Oracle® Enterprise Service Bus
Quick Start Guide
10g (10.1.3.1.0)
B28212-01

September 2006
Contents

Preface .................................................................................................................................................. xi
  Audience ............................................................................................................................................ xi
  Documentation Accessibility ............................................................................................................ xi
  Related Documents ....................................................................................................................... xii
  Conventions ...................................................................................................................................... xii

1 Introduction to Oracle Enterprise Service Bus
  How this Guide Is Organized ........................................................................................................ 1-1
  Oracle Enterprise Service Bus Concepts ..................................................................................... 1-1
    Oracle Enterprise Service Bus Architecture .............................................................................. 1-2
    Oracle Enterprise Service Bus and Oracle SOA Suite Integration ........................................ 1-3
  Oracle Enterprise Service Bus Integration Features .................................................................... 1-3
    Connectivity ................................................................................................................................. 1-3
    Document Transformation .......................................................................................................... 1-5
    Content Based Routing .............................................................................................................. 1-5
  Creating, Configuring, and Managing an Oracle Enterprise Service Bus .................................. 1-6
    Introduction to Oracle JDeveloper ............................................................................................ 1-7
    Introduction to the Oracle Enterprise Service Bus Control Console .................................. 1-8
      Services Panel ........................................................................................................................... 1-9
      Configuration Area ..................................................................................................................... 1-10

2 Installing the Oracle Enterprise Service Bus
  Hardware and Software Requirements for Installing Oracle Enterprise Service Bus Server... 2-1
  Setting the User to Belong to the Administrators Group ............................................................ 2-2
  Setting the Environment Variables ............................................................................................... 2-3
  Oracle Enterprise Service Bus Installation Types ........................................................................ 2-3
    Installation and Configuration ................................................................................................... 2-3
  Starting and Stopping Oracle Enterprise Service Bus Components ...................................... 2-6
  Deinstalling Oracle Enterprise Service Bus .................................................................................. 2-6

3 Using the CustomerDataTutorial
  Introduction ................................................................................................................................. 3-1
  Using the Tutorial ....................................................................................................................... 3-2
4 Installing Oracle JDeveloper

Installing Oracle JDeveloper ................................................................. 4-1
Opening Oracle JDeveloper ................................................................. 4-2
Configuring AS Connection for SOA Suite: OC4J Middle Tier .......... 4-3
Configuring Integration Server Connection ....................................... 4-6

5 Building the CustomerDataTutorial

Introduction to the CustomerData Tutorial ........................................ 5-1
Step-By-Step Instructions for Setting Up the Tutorial End-to-End ...... 5-2
Creating the Directory Structure ......................................................... 5-3
Creating an Oracle JDeveloper Application and Project .................. 5-3
Importing the Schema Definition (.XSD) Files ................................. 5-5
Creating an Oracle Enterprise Service Bus System ......................... 5-8
Creating an Inbound File Adapter Service – CustIn ......................... 5-8
Creating an Outbound Database Adapter Service – CustDBOut ...... 5-12
Creating an Outbound JMS Adapter Service – CRMOut .................. 5-21
Creating the Outbound Routing Service – CustOut_RS ................. 5-25
Specifying Routing Rules from CustIn_RS to CustOut_RS ............... 5-27
Specifying Routing Rules from CustOut_RS to CustDBOut ............... 5-31
Specifying Routing Rules from CustOut_RS to CRMOut ................. 5-34
Registering Services with Oracle Enterprise Service Bus and Viewing in the ESB Control Console 5-36
Adding an Expression Filter to the CustOut_RS Routing Service ....... 5-38

Index
List of Figures

1–1 Oracle Enterprise Service Bus Architecture ................................................................. 1-2
1–2 Oracle Enterprise Service Bus and Oracle SOA Suite Integration ............................ 1-3
1–3 ESB Project Design View in Oracle JDeveloper ............................................................... 1-7
1–4 Sample Oracle Enterprise Service Bus Control Console ............................................. 1-9
1–5 Icons and Images Used in the Oracle Enterprise Service Bus Control Console ....... 1-9
1–6 Configuration Pane - Diagram Tab with Throughput Overlay Metrics .................... 1-11
2–1 Oracle Application Server SOA Suite 10.1.3.1.0 Installation ........................................ 2-4
2–2 The Configuration Assistants Page ................................................................................. 2-5
2–3 End of Installation Page .................................................................................................. 2-5
3–1 ESB Control Console ...................................................................................................... 3-4
4–1 The Check for Updates Welcome Page ......................................................................... 4-2
4–2 Oracle JDeveloper – Initial Display .............................................................................. 4-3
4–3 The Create Application Server Connection Type Page ............................................. 4-4
4–4 The Create Application Server Connection Page ....................................................... 4-5
4–5 The Edit Application Server Connection Dialog Box ............................................... 4-5
4–6 The Edit Application Server Connection Test Page ................................................... 4-6
4–7 The Edit Application Server Connection Success Page ............................................. 4-6
4–8 The Create Integration Server Connection Page ......................................................... 4-7
4–9 The Edit Integration Server Connection Dialog Box ................................................. 4-8
4–10 The Edit Integration Server Connection Test Page ................................................... 4-8
4–11 The Edit Integration Server Connection Success Page ............................................ 4-9
5–1 Illustration of Scenario .................................................................................................. 5-2
5–2 CustomerData Tutorial Directory Structure ............................................................... 5-3
5–3 The Create Application Dialog Box .......................................................................... 5-4
5–4 The New Gallery Dialog Box ..................................................................................... 5-4
5–5 The Create ESB Project Dialog Box ........................................................................... 5-5
5–6 Oracle JDeveloper – Application and ESB Project Added ...................................... 5-5
5–7 The Import Dialog Box ................................................................................................ 5-6
5–8 The Web Source Dialog Box ........................................................................................ 5-6
5–9 The Web Source Dialog Box ........................................................................................ 5-7
5–10 Applications Navigator – ESBSamples/CustomerData/Web Content ..................... 5-7
5–11 The Create System/Group Icon ................................................................................. 5-8
5–12 The Create ESB System Or Service Group Dialog Box ........................................... 5-8
5–13 Adapter Configuration Wizard Icon .......................................................................... 5-9
5–14 The Operation Page ................................................................................................... 5-10
5–15 Type Chooser - CustomerData .................................................................................. 5-11
5–16 Adapter Configuration Wizard – Messages page ....................................................... 5-11
5–17 The Create Database Connection Type Page ............................................................ 5-13
5–18 The Create Database Connection Authentication Page ......................................... 5-13
5–19 The Create Database Connection Page .................................................................... 5-14
5–20 The Select Library Dialog Box .................................................................................. 5-14
5–21 The Create Library Dialog Box ................................................................................ 5-15
5–22 The Select Path Entry Dialog Box ............................................................................ 5-15
5–23 The Create Library Dialog Box - Olite40.jar ........................................................... 5-16
5–24 The Select Library Dialog Box - Olite40.jar ............................................................ 5-16
5–25 The Create Database Connection Page .................................................................... 5-17
5–26 The Create Database Connection Page .................................................................... 5-17
5–27 The Create Database Connection Test Page ............................................................ 5-18
5–28 The Service Connection Page .................................................................................... 5-18
5–29 Adapter Configuration Wizard – Operation Type ..................................................... 5-19
5–30 Import Tables Dialog Box ........................................................................................ 5-20
5–31 Select Table – SYSTEM.CUSTOMER_DATA ............................................................... 5-20
5–32 JMS Provider Page .................................................................................................... 5-22
5–33 Select Destination dialog box .................................................................................... 5-23
List of Tables

<table>
<thead>
<tr>
<th></th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–1</td>
<td>Oracle Adapter Services..........................................................................</td>
<td>1-4</td>
</tr>
<tr>
<td>2–1</td>
<td>System Requirements for Installing Oracle Enterprise Service Bus</td>
<td>2-2</td>
</tr>
</tbody>
</table>
This guide provides an overview of Oracle Enterprise Service Bus and step-by-step instructions to help you get started with installation, using the Oracle Enterprise Service Bus Control Console and Oracle JDeveloper.

This preface includes the following topics:

- Audience
- Documentation Accessibility
- Conventions

**Audience**

This document is intended for all users who want to install and quickly get started using Oracle Enterprise Service Bus.

**Documentation Accessibility**

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at


**Accessibility of Code Examples in Documentation**

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

**Accessibility of Links to External Web Sites in Documentation**

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.
TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.

Related Documents

For more information, see the following documents:

- Oracle Enterprise Service Bus Developer’s Guide
- Oracle Application Server Adapters for Files, FTP, Databases, and Enterprise Messaging User’s Guide

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
This chapter describes how this guide is organized, introduces Oracle Enterprise Service Bus features, concepts and tools, as well as presents the scenario that you can build, configure, and run using the steps provided in this tutorial.

This chapter contains the following topics:

- "How this Guide Is Organized" on page 1-1
- "Oracle Enterprise Service Bus Concepts" on page 1-1
- "Creating, Configuring, and Managing an Oracle Enterprise Service Bus" on page 1-6

### How this Guide Is Organized

This guide is divided into four chapters. The following table provides a brief description of each chapter:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, &quot;Introduction to Oracle Enterprise Service Bus&quot;</td>
<td>Introduces Oracle Enterprise Service Bus features, concepts, and the scenario that the tutorial implements.</td>
</tr>
<tr>
<td>Chapter 2, &quot;Installing the Oracle Enterprise Service Bus&quot;</td>
<td>Lists hardware and software requirements and instructions for installing Oracle Enterprise Service Bus and the steps for starting the software required to run the tutorial.</td>
</tr>
<tr>
<td>Chapter 3, &quot;Using the CustomerDataTutorial&quot;</td>
<td>Provides step-by-step instructions on using, modifying, and registering the CustomerData tutorial.</td>
</tr>
<tr>
<td>Chapter 4, &quot;Installing Oracle JDeveloper&quot;</td>
<td>Provides step-by-step instructions on installing Oracle JDeveloper, configuring AS Connection for SOA Suite and ESB Standalone, and also configuring integration server connection.</td>
</tr>
<tr>
<td>Chapter 5, &quot;Building the CustomerDataTutorial&quot;</td>
<td>Provides step-by-step instructions for creating the CustomerData tutorial.</td>
</tr>
</tbody>
</table>

### Oracle Enterprise Service Bus Concepts

An enterprise service bus moves data among multiple endpoints, both within and outside of an enterprise. It uses open standards to connect, transform, and route business documents (as Extensible Markup Language (XML) messages), among disparate applications. It enables monitoring and management of business data, with minimal impact on existing applications. An enterprise service bus is the underlying
infrastructure for delivering a service-oriented architecture (SOA) and event-driven architecture (EDA).

Oracle Enterprise Service Bus is the foundation for services using SOA and EDA. At its core, it is a loosely coupled application framework that provides your business with increased flexibility, reusability, and overall responsiveness in a distributed, heterogeneous, message-oriented environment using industry standards.

**Oracle Enterprise Service Bus Architecture**

As shown in Figure 1–1, Oracle Enterprise Service Bus consists of following components:

- **ESB Server**
  The ESB Server is the server to which you register the ESB services that you have designed using JDeveloper ESB Designer and configured using the ESB Console. The ESB Server supports multiple protocol bindings including HTTP/SOAP, JMS, JCA, WSIF, and Java that ensure guaranteed, reliable message delivery using synchronous/asynchronous, request/reply or publish/subscribe models. However, ESB Server does not support Remote Method Invocation (RMI).

- **ESB Console**
  The ESB Console provides a Web-based interface for managing, administering, and debugging services that you have registered with the ESB Server.

- **ESB Metadata Server**
  The database that holds your ESB metadata such as schemas, transformations, and routing rules.

- **Oracle JDeveloper**
  Oracle JDeveloper is a graphical and user-friendly way to model, edit, and design the services that comprise an Oracle Enterprise Service Bus system.

![Oracle Enterprise Service Bus Architecture](image)
Oracle Enterprise Service Bus and Oracle SOA Suite Integration

Oracle Enterprise Service Bus is a component of Oracle SOA Suite. Oracle SOA Suite is a standards-based suite that provides an integrated design-time environment and a common architecture for developing enterprise applications. Oracle SOA Suite enables services to be created, managed, and orchestrated into composite applications and business processes. Figure 1–2 shows the integration between Oracle Enterprise Service Bus and Oracle SOA Suite.

*Figure 1–2 Oracle Enterprise Service Bus and Oracle SOA Suite Integration*

Oracle Enterprise Service Bus Integration Features

Oracle Enterprise Service Bus features that provide the ability to integrate applications fall into three broad categories, as described in the following sections:

- "Connectivity" on page 1-3
- "Document Transformation" on page 1-5
- "Content Based Routing" on page 1-5

Connectivity

Connectivity is provided through adapter services and Simple Object Access Protocol (SOAP) invocation services, as described in the list that follows:

- SOAP invocation services

  SOAP invocation services provide connectivity with external SOAP clients, such as Oracle BPEL Process Manager, Apache Axis, and Microsoft.NET. You can call Oracle Enterprise Service Bus services from such clients, or you can call those products from Oracle Enterprise Service Bus.

  You might call Oracle Enterprise Service Bus from Oracle BPEL Process Manager, for example, to take advantage of the document routing features that Oracle Enterprise Service Bus provides (as described in the next section), or you might call Microsoft.NET from Oracle Enterprise Service Bus to integrate a legacy Microsoft.NET infrastructure.
Adapter services

Oracle Application Server adapters provide bidirectional, real-time data access to virtually any data source in your enterprise.

An adapter either listens for, or polls for, events in the source application it supports. When listening for events, an adapter registers as a listener for the application that is configured to push events to the adapter. The adapter can also poll the back-end application, such as a database or file, for the events required by Oracle Enterprise Service Bus.

By registering adapters with Oracle Enterprise Service Bus (using a wizard), you integrate external data sources with Oracle Enterprise Service Bus, and ultimately, with each other.

Currently, Oracle Enterprise Service Bus Server supports the Oracle adapters described in Table 1–1 and enables you to define inbound and outbound adapter services for each. An inbound adapter service receives data from an external data source and transforms it into an XML message. An outbound adapter service sends data to a target application by transforming an XML message into the native format of the given adapter.

Table 1–1  Oracle Adapter Services

<table>
<thead>
<tr>
<th>Adapter Service</th>
<th>Description</th>
</tr>
</thead>
</table>
| File/FTP adapter service | An inbound file/FTP adapter service reads data from a local/remote file system, transforms the file data into an XML message and sends it to Oracle Enterprise Service Bus when a new text file appears in a local file system.  
An outbound file adapter service transforms the contents of an XML message to a text file and writes it to a local/remote file system. |
| Database adapter service | An inbound database adapter service sends an XML message to Oracle Enterprise Service Bus when a SQL insert, update, or delete operation is performed against a database.  
An outbound database adapter transforms the contents of an XML message into a SQL insert, update, or delete operation on the target database. |
| JMS adapter service | An inbound JMS adapter service sends XML messages to Oracle Enterprise Service Bus when a new XML message is added to a Java Message Service external to Oracle Enterprise Service Bus.  
An outbound JMS adapter service writes messages from Oracle Enterprise Service Bus on to a Java Message Service external to Oracle Enterprise Service Bus. |
| MQ adapter service | An inbound Native MQSeries adapter service sends an XML message to Oracle Enterprise Service Bus when new XML message is received by a queue.  
An outbound Native MQSeries adapter service writes messages from Oracle Enterprise Service Bus to a message queue. |
| AQ adapter service | An inbound AQ adapter service sends an XML message to Oracle Enterprise Service Bus when a new message is received by an Oracle Advanced Queuing single or multiconsumer queue.  
An outbound AQ adapter service sends messages from Oracle Enterprise Service Bus to an Oracle Advanced Queuing single or multiconsumer queues. |
Any service, except an inbound adapter service, that you create as an Oracle Enterprise Service Bus service, is automatically created as a SOAP service without requiring you to provide configuration details. The Oracle Enterprise Service Bus Control Console (described in “Introduction to the Oracle Enterprise Service Bus Control Console” on page 1-8) lists the concrete WSDL URL for these services on the Definitions tab. You can use the concrete WSDL URL to invoke the service using SOAP over Hypertext Transfer Protocol (HTTP) from JDeveloper or Microsoft.Net.

See Also: Oracle Application Server Adapters for Files, FTP, Databases, and Enterprise Messaging Guide for information on these adapters.

Document Transformation

Oracle Enterprise Service Bus includes a standards-based data mapper (from within the Oracle JDeveloper or the Eclipse Platform modeling environment). The data mapper specifies an .xslt file to transform data from one XML schema to another, thus enabling data interchange among applications using different schemas. Multiple transformations may be required to achieve the desired result. These transformations can be reused, as needed, across your enterprise.

Content Based Routing

Data contained within XML messages are distributed from the source application to a target application using routing services. As the name suggests, a routing service determines how a message gets from one point to another within the Oracle Enterprise Service Bus environment as defined by the routing rules and transformations it applies on the XML message and the various rules it applies. Also, routing service enables decoupling external service endpoints from business processes in BPEL. As you can define rules to route messages based on the message content, the routing service is also known as content-based routing service.

Routing rules specify the set of services (referred to as target services) that Oracle Enterprise Service Bus will invoke when the routing service receives a message.

When you configure routing rules, you specify the following details:

- Whether a filter expression is applied.
  A filter expression specifies that the contents (payload) of a message be analyzed before any service is invoked. For example, using the scenario described in "Introduction to the CustomerData Tutorial" on page 5-1, you might apply a filter expression that specifies that the database adapter service be invoked only if the message includes customer contact information.

- Whether a document transformation is applied.
  Refer to "Document Transformation" on page 1-5 for information about transformations.

- Whether execution is synchronous or asynchronous
If you specify that execution is synchronous, then Oracle Enterprise Service Bus invokes the target service immediately. Control is not returned to the current service until the message has been received by the target service for processing.

If you specify that execution is asynchronous, then Oracle Enterprise Service Bus uses JMS for delivering the message to the target service, which will be invoked at a later time. Control is returned to the current service immediately, before the target service has received the message.

Creating, Configuring, and Managing an Oracle Enterprise Service Bus

The two main tools for creating, configuring, and managing an Oracle Enterprise Service Bus are as follows:

- Oracle Enterprise Service Bus Control Console
  The Oracle Enterprise Service Bus Control Console is primarily intended for run time use. It enables you to:
  - View the enterprise service bus configuration graphically.
    As shown in Figure 1–4, the Oracle Enterprise Service Bus Control Console provides a graphical representation of the inbound and outbound adapter services, the routing services, and the connections among them.
  - Adjust routing rules
    The Oracle Enterprise Service Bus Control Console provides property pages that enable you to specify or adjust the routing rules for routing services. For example, you can use it to specify a filter expression, add or change the document transformation file associated with a routing operation, and so on.
  - View instance data
    The Oracle Enterprise Service Bus Control Console enables you to view run-time data of an instance.
    You can also use the Oracle Enterprise Service Bus Control Console to create routing services, systems, and service groups. Systems and service groups are described in "Introduction to the Oracle Enterprise Service Bus Control Console" on page 1-8.

- Oracle JDeveloper
  Oracle JDeveloper is primarily intended for specifying the overall enterprise service bus creation and configuration. It enables you to:
  - Create inbound and outbound adapter services
    Oracle JDeveloper provides an adapter configuration wizard that assists you in creating inbound and outbound adapter services.
  - Create routing services from inbound adapter services
    When you complete the adapter configuration wizard for an inbound adapter service, Oracle JDeveloper gives you the opportunity to create a routing service from the newly created inbound adapter service.
  - Select the routing service that will route to an outbound routing service
    When you complete the adapter configuration wizard for an outbound adapter service, Oracle JDeveloper gives you the opportunity to specify the routing service that will route to the newly created outbound routing service.
Specify or create document transformation files (.xslt files)

As part of creating routing services from an inbound adapter service or specifying an existing routing service to an outbound adapter service, you can specify if a transformation is needed.

If a transformation is needed, you can specify that an existing transformation file be used, or specify that you want to create a new transformation file. If you specify that you want to create a new transformation file, Oracle JDeveloper opens the data mapper tool to enable you to do so.

The following two sections describe these tools in more detail:
- "Introduction to Oracle JDeveloper" on page 1-7
- "Introduction to the Oracle Enterprise Service Bus Control Console" on page 1-8

Introduction to Oracle JDeveloper

Oracle JDeveloper is an integrated development environment (IDE) for building applications and Web services using Java, XML, and SQL standards. Oracle JDeveloper supports the entire development life cycle with integrated features for designing, coding, debugging, testing, profiling, tuning, and registering applications. A visual and declarative development approach and the Oracle Application Development Framework (ADF) work together to simplify application development and reduce coding tasks.

Oracle Enterprise Service Bus provides support for the following services and adapters in Oracle JDeveloper:
- Transformations and routing from inbound and outbound adapter services
- Adapters (File/FTP, Database, and Java Messaging Service (JMS))

Figure 1–3 shows Oracle JDeveloper with a transformation being designed for a project.

Figure 1–3  ESB Project Design View in Oracle JDeveloper
The Applications Navigator displays the project files that you have created. In Figure 1–3, for example, the Applications Navigator includes an application named ESBSamples, which contains the project node entitled CustomerData.

When the CustomerData node is expanded (as it is in Figure 1–3) you can see the .wsdl files that define the adapter services for the application, and the .xsd files that define the structure of the data that will be routed across the Oracle Enterprise Service Bus.

When you right-click a node, a menu of commands is displayed. The menu commands displayed depend on the node selected. For example, when you right-click an ESB project (such as CustomerData in Figure 1–3), the following commands are included in the menu:

- **New**
  
  This command opens the New Gallery dialog box, which provides access to dialog boxes and wizards that enable you to create new projects, create inbound and outbound adapter services, and access the document transformation tool.

  For example, if you expand the **Business Tier** category and then select **Web Services** in the New Gallery dialog box, as shown in Figure 1–1, you can access the Adapter Configuration Wizard.

- **Register with ESB**

  This command enables you to register the adapter services, transformations, and routing services that you design using Oracle JDeveloper with Oracle Enterprise Service Bus.

**Introduction to the Oracle Enterprise Service Bus Control Console**

You monitor and make run-time adjustments to the Oracle Enterprise Service Bus configuration using the Oracle Enterprise Service Bus Control Console, an example of which is shown in Figure 1–4. As shown in Figure 1–4, the Console is vertically divided into two main parts, Services panel and the Configuration area as described in the following sections:

- "Services Panel" on page 1-9
- "Configuration Area" on page 1-10
Icons and images used to represent objects in the Oracle Enterprise Service Bus Control Console are shown in Figure 1–5.

**Services Panel**

Services are the means by which data gets from one application to another and in and out of the Oracle Enterprise Service Bus environment. The services navigation tree, which appears on the left side of the console, helps you organize and manage services. Services are presented in the navigation tree by a gear icon.

The following organizational units for services (which you create), serve the same purpose as directories serve in a file system:

- **System** (required)

  A **system** is a representation of a single application, proxy for an application, or a technical system. Examples of systems are:
- An Oracle Applications instance
- A set of transformations, Oracle BPEL Process Manager services, and adapter services for an SAP instance
- A set of transformations, BPEL Services, and database services for a custom database application
- A standalone Oracle Business Activity Monitoring instance, complex event processing (CEP) services, and other related services
- An Oracle B2B engine (that serves as a proxy for trading partners) and related transformation services and other services
- A set of services, adapter services, and Oracle BPEL Process Manager services representing a bridge to a third party integration infrastructure (such as webMethods, Inc, and IBM infrastructures)

As shown in Figure 1–5, a system is represented in the Oracle Enterprise Service Bus Control Console by a stacked disks icon.

■ Service group (optional)

A service group is a set of related services.

A service can belong to only one service group. Different services, with the same name can belong to different service groups, just as different files with the same file name can reside in different directories in a file system.

As shown in Figure 1–5, a service group is represented in the navigation tree by a folder icon on which a gear icon is superimposed.

Every service you create must be defined as a child of either a service group or a system. A service is uniquely identified by its full path within the System/Service Group/service (or System/service) structure. A service is represented by a gear icon in the services navigation tree, as shown in Figure 1–5.

Configuration Area

The configuration area, which appears on the right side of the console, consists of a number of tabbed pages. The tabbed pages include the following, depending on which item you select in the Services panel:

■ Diagram Tab

The panel that is presented when you click the Diagram tab contains three parts: the diagram itself, the navigator, and overlay metrics.

- Diagram

The diagram shows the relationship among the selected service and other services. Oracle Enterprise Service Bus creates this diagram automatically, based on the definitions you specify for each service.

When you select an item from the navigation tree and click the Diagram tab, the selected item is highlighted in blue within the diagram. In the diagram, the following conventions, which are presented in Figure 1–5, are used:

* Adapter services are represented by rectangles with squared corners (and with a long horizontal plane).
* Routing services are represented by rectangles with rounded corners (and with long vertical planes).
Communication between services is represented by the lines between the services.

A routing service filter expression is indicated by a funnel.

A transformation is indicated by the presence of a yellow box overlaying the routing service rectangle.

- **Navigator**
  
  The navigator indicates which area of the diagram is currently being displayed in relation to the entire diagram. This is useful for large diagrams that extend beyond the area that can be presented in the diagram region. When you move the scroll bar in the diagram region, notice that the blue window in the navigator scrolls also, to highlight the portion of the diagram that is currently visible.

- **Overlay metrics**
  
  Overlay metrics enable you to select which metrics, if any, you want to be superimposed on the diagram. For example, if you select **Processing Time (in milliseconds)**, the diagram tab looks similar to Figure 1–6.

*Figure 1–6  Configuration Pane - Diagram Tab with Throughput Overlay Metrics*

- **Definition Tab**

  The Definition tab shows details on how an item selected from the navigation tree is defined. For outbound adapter services and routing services, these details including the concrete WSDL URL, which you can use to invoke the service using SOAP over HTTP from another application.

- **Routing Rules Tab**
The routing rules tab is presented only when you select a routing service from the navigation tree. It shows the rules that govern how a message is routed by the routing service. Refer to "Content Based Routing" on page 1-5 for more information on routing services.

- Trackable Fields Tab

The Trackable Fields Tab enables the ability to define XPATH expressions that identify elements within a service's XML document to view and search in the instance data.
This chapter describes the system requirements for, and instructions on how to install, Oracle Enterprise Service Bus through Oracle Application Server SOA Suite. It also provides steps on starting the required software to run the tutorial.

This chapter contains the following topics:

- "Hardware and Software Requirements for Installing Oracle Enterprise Service Bus Server" on page 2-1
- "Setting the User to Belong to the Administrators Group" on page 2-2
- "Setting the Environment Variables" on page 2-3
- "Oracle Enterprise Service Bus Installation Types" on page 2-3
- "Installation and Configuration" on page 2-3
- "Starting and Stopping Oracle Enterprise Service Bus Components" on page 2-6
- "Deinstalling Oracle Enterprise Service Bus" on page 2-6

Hardware and Software Requirements for Installing Oracle Enterprise Service Bus Server

Before you install Oracle Enterprise Service Bus Server, ensure that the system on which you plan to install it meets the requirements described in Table 2-1.
Setting the User to Belong to the Administrators Group

The operating system user performing the installation must belong to the Administrators group.

Note: The user must be listed directly in the Administrators group. The user cannot belong to the group indirectly (for example, by being a member of a group that is part of the Administrators group).

To check if you belong to the Administrators group for Windows 2000, Windows 2003, and Windows XP, perform the following steps:


   Note: For Windows 2003, right-click the local computer icon on the desktop and select Manage.

2. On the left pane, expand the Local Users and Groups option, and select Users. The name, full name, and description of the users on the computer are listed on the right side.

3. Right-click the user that you want to set as administrator, and select Properties. The Properties dialog box is displayed.

4. Select the Member Of tab.

---

Table 2–1 System Requirements for Installing Oracle Enterprise Service Bus

<table>
<thead>
<tr>
<th>Element</th>
<th>Requirement</th>
<th>Checked by Installer (Yes/No)</th>
</tr>
</thead>
</table>
| Operating system| The operating system requirements for Oracle Enterprise Service Bus are the same as those for Oracle Application Server. In addition, the Oracle Enterprise Service Bus has the same requirements as Oracle Application Server for the following:  
- Operating system patches and packages, swap space requirements, and kernel parameter settings on Unix and Linux  
- Processor, TEMP directory, virtual memory, and swap space on Microsoft Windows | Yes                                           |
| Disk space      | 2 GB                                                                        | No                             |
| Memory          | 1.5 GB RAM minimum                                                          | Yes                            |
| Swap space      | 1535 MB minimum                                                            | Yes                            |
| Web browser     | Internet Explorer 6.0 SP2, Netscape 7.2, Mozilla 1.7, Firefox 1.0.4          | No                             |
| Monitor         | Configured to display at least 256 colors                                   | Yes                            |
| CPU Speed       | 1 GHz                                                                       | Yes                            |

Refer to Oracle Application Server Installation Guide 10g Release 3 (10.1.3) for the operating system you are using.
5. If you are not a member of the Administrators group, get an administrator to add you to the group or log in as a user who is a member of the Administrators group.

**Setting the Environment Variables**

The operating system user who will be installing Oracle Application Server needs to set (or unset) the following environment variables.

- **ORACLE_HOME**: Must not be set.
- **ORACLE_SID**: Must not be set.
- **TNS_ADMIN**: Must not be set.
- **PATH**: Must not be longer than 1023 characters.
- **TEMP**: Optional. If unset, defaults to `C:\temp`

To set environment variables, perform the following steps:

1. Display the System Control Panel.
   - Windows 2000: Click **Start**, **Settings**, **Control Panel**, and **System**.
   - Windows 2003: Click **Start**, **Control Panel**, and **System**.
   - Windows XP: Click **Start**, **Control Panel**, and then double-click **System**.
2. Click the **Advanced** tab.
3. Click **Environment Variables**. The Environment Variables dialog box is displayed.
4. To change the value of a variable, select the variable and click **Edit**.

**Oracle Enterprise Service Bus Installation Types**

Oracle Enterprise Service Bus is installed as part of Oracle Application Server SOA Suite. Following list provides the installation types provided by Oracle Application Server SOA Suite:

- **Basic Install**
  This installation type installs the J2EE Server and the SOA Suite of applications including BPEL, ESB, OWSM.

  **Note:** This guide covers only Basic Installation. For more information on Oracle Application Server SOA Suite installation, refer to the *Oracle Application Server Installation Guide* for your operating system.

- **Advanced Install**
  This installation type provides options for different types of install, custom port selection, renaming OC4J instance name, RAC databases, and more.

**Installation and Configuration**

To install Oracle Enterprise Service Bus, you need to perform the following steps:
1. Download the Oracle Application Server SOA Suite from otn.oracle.com or the Oracle Application Server SOA Suite install CD. Expand the content if necessary into the local file system.

2. Navigate to the Disk1 folder.

3. Double-click setup.exe. The Oracle Application Server SOA Suite 10.1.3.1.0 Installation dialog box is displayed, as shown in Figure 2–1.

Figure 2–1 Oracle Application Server SOA Suite 10.1.3.1.0 Installation

4. Select Basic Install.

5. Specify field values as described in the following list.

   - AS Instance Name: myesbsoa
   - AS Administrator Password: welcome1
   - Confirm Password: welcome1

6. Click Install. The Preparing to Install message box is displayed.

7. When the Installation completes, the Configuration Assistants page is displayed, as shown in Figure 2–2.
8. Allow the configuration assistants to run. When they complete, the End of Installation page is displayed, as shown in Figure 2–3.

Figure 2–3 End of Installation Page

9. Click Exit, and then Yes when prompted for confirmation.
Starting and Stopping Oracle Enterprise Service Bus Components

The following sections describe how to start and stop all the Oracle Enterprise Service Bus components:

Follow these instructions to start and stop the server:

1. Select **Start, All Programs, Oracle - Oracle Home, Oracle Process Manager, Start Oracle Process Manager** to start all processes.
2. Select **Start, All Programs, Oracle - Oracle Home, Oracle Process Manager, Stop Oracle Process Manager** to stop all process.
3. Select **Start, All Programs, Oracle - Oracle Home, Oracle ESB, ESB Control** to open the Oracle Enterprise Service Bus Control Console. This prompts you to enter your single sign-on username and password. Enter your single sign-on username and password, and click Login. The Oracle Enterprise Service Bus Control Console is displayed.

Using the Command Prompt

You can also start and stop all the Oracle Enterprise Service Bus SOA Suite components using the command prompt. Follow these instructions to start and stop Oracle Enterprise Service Bus SOA Suite components in the command prompt using Oracle Process Manager:

1. Start a command prompt and navigate to the `Oracle_Home\opmn\bin` folder.
2. Type the following command to start all processes:
   ```
   opmnctl startall
   ```
3. Type the following command to check the status of all the processes registered with opmn:
   ```
   opmnctl status
   ```
4. Type the following command to stop all processes:
   ```
   opmnctl shutdown
   ```

Deinstalling Oracle Enterprise Service Bus

To deinstall Oracle Enterprise Service Bus, follow these steps:

1. On the host where Oracle Enterprise Service Bus is installed, log in as the system user who installed the instance you want to deinstall.
2. Stop all processes associated with the instance of Oracle Enterprise Service Bus you want to deinstall.
   Refer to [Oracle Application Server Administrator’s Guide](#) for information on how to stop the processes.
3. From the desktop **Start** button, select **All Programs > Oracle – Oracle-Home > Oracle Installation Products > Universal Installer**, where `Oracle_Home` is the name of the Oracle home where you installed Oracle Enterprise Service Bus.
   An Oracle Universal Install Window window opens to inform you that the Oracle Universal Install is being prepared for launch. This window closes and the Welcome page for Oracle Universal Install displays.
4. In the Welcome page, click **Deinstall Products**. The Inventory dialog box is displayed.
5. Select the instance of Oracle Enterprise Service Bus that you want to deinstall, and then click **Remove**. A Confirmation dialog box is displayed.

6. Verify that the products and components listed are the ones you want to deinstall, and then click **Yes**. The Remove dialog box is displayed.

7. Monitor the progress of the deinstallation. When it completes, in the Inventory dialog box, click **Close**.

8. In the Welcome page, click **Cancel**, and then **Yes**, when you are asked for confirmation.

9. Restart your computer to stop any remaining processes associated with the deinstallation.

10. Delete any files that remain in the deleted instance’s Oracle home directory.

To deinstall the Oracle Enterprise Service Bus SOA Suite, perform the following steps:

1. On the host where Oracle Enterprise Service Bus is installed, log in as the system user who installed the instance you want to deinstall.

2. Stop all processes associated with the instance of Oracle Enterprise Service Bus SOA Suite that you want to deinstall.

3. From the desktop **Start** button, select **All Programs, Oracle – Oracle-Home, Oracle Installation Products, Deinstall** where *Oracle_Home* is the name of the Oracle home where you installed Oracle Enterprise Service Bus SOA Suite.

   The Oracle Application Server 10.1.3.1.0 SOA Deinstallation dialog box is displayed with the following message:

   "This will deinstall the following Oracle Application Server 10.1.3.1.0 instance: J2EE Server, SOA Suite, and Process Management."

4. Check the **Clean up the Oracle home after deinstallation** check box, and click **OK**.

   You have successfully deinstalled the Oracle Enterprise Service Bus SOA Suite.
Using the CustomerDataTutorial

This chapter describes how to use and modify the CustomerData tutorial. It contains the following topics:

- **Introduction** on page 3-1
- **Using the Tutorial** on page 3-2

**Introduction**

This tutorial teaches you how to use Oracle JDeveloper ESB Designer and ESB Control Console to deploy and test the CustomerData tutorial. In addition, you will also modify the CustomerData tutorial by creating a new inbound file adapter service.

The CustomerData tutorial consists of following steps:

1. Legacy customer files are picked up from a directory by an inbound adapter service named CustIn.

2. The CustIn adapter service sends the file data to a routing service named CustIn_RS.

3. The CustIn_RS routing service converts the file data to a canonical data structure and sends the file data to the CustOut_RS routing service.

   By converting the data structure to a canonical data structure, the data can be moved across the Oracle Enterprise Service Bus as a single message format. When the message is ready to be delivered to an external target, the message format can be converted to the format required by that target.

4. The CustOut_RS routing service:

   - Sends the message in the canonical format to the CRMOut adapter service for delivery to the Customer Relationship Management Application.
   - Transforms the message to the structure required by the Customer Information Database, applies a filter to determine if payload contains a customer address that is in the United States.
     - If the customer address is in the United States, then the message is sent to the CustDBOut adapter service for delivery to the Customer Information Database.
     - If the customer address is not in the United States, then the message is not delivered to the Customer Information Database.
Using the Tutorial

In this section, you will run the ESB CustomerData tutorial. Perform the following steps to run the tutorial:

1. From the desktop Start button, select All Programs, Oracle – Oracle-Home, Oracle Process Manager, Start Oracle Process Manager to start opmn and all managed processes. The Start Oracle Process Manager window appears and then closes.

2. Download the CustomerSample.zip file and unzip to the folder C:\Customer.

3. From the desktop Start button, select All Programs, Oracle – Oracle-Home, Oracle ESB 10.1.3, Developer Prompt. The Developer Prompt window is displayed.

4. On the prompt, type the following commands:
   
   cd <ORACLE_HOME>\integration\esb\olite\bin
   sql_olite.bat @C:\\Customer\create_customer.sql

5. Open a new prompt window and type the following commands:
   
   cd <ORACLE_HOME>\integration\esb\bin
   import C:\Customer\CustomerData.zip

   The CustomerData metadata gets imported.

6. Open the ESB Control Console window, login with your username and password, and then click the Refresh button in the ESB Control Console window to view the updated services.

   **Note:** Refer to "Starting and Stopping Oracle Enterprise Service Bus Components" to open the ESB Control Console.

This section contains the following topics:

- "Viewing the Services in the ESB Control Console"
- "Step-By-Step Instructions for Running the Tutorial"

Viewing the Services in the ESB Control Console

1. View the Oracle Enterprise Service Bus configuration in the Oracle Enterprise Service Bus Control Console, as follows:

   - If the Oracle Enterprise Service Bus Control Console is currently open:
     
     Click the Services button, the Oracle Enterprise Service Bus Control Console Services window is displayed. Click the Refresh button and then click CustOut_RS.

   - If the Oracle Enterprise Service Bus Control Console is not open:
     
     Open the Oracle Enterprise Service Bus Control Console, as described in “Starting and Stopping Oracle Enterprise Service Bus Components” on page 2-6) and then click CustOut_RS.

     The Diagram tab appears as shown in Figure 3–1.

2. Click the Routing Rules tab to view the defined routing rules.
Step-by-Step Instructions for Running the Tutorial

You can run the CustomerData tutorial by following these steps:

1. Copy the `LegacyCustomer.xml` file from the `C:\Customer` directory to the `C:\Customer\In` directory, for the CustIn adapter service to read into enterprise service bus configuration.

2. In the ESB Control Console, click the **Instances** tab.

3. Click **CustOut_RS** to view the execution path.

   The diagram in the ESB Control Console indicates that the filter expression you added to the **CustOut_RS** routing service evaluated to TRUE because the message content was for a customer located in the US. Also, you can view in the ESB Control Console that the message was successfully sent to the **CRMOut JMS** adapter service.

4. Copy the `C:\Customer\LegacyCustomerCanada.xml` file to the `C:\Customer\In` directory.

5. In the ESB Control Console, click the **Instances** icon shown highlighted in the following graphic:

   ![Instance Icon]

6. Click **CustOut_RS**.

   **Figure 3–1** indicates that the filter expression you added to the **CustOut_RS** routing service evaluated to FALSE because the message content was not for a customer located in the US. Also, you can view in the ESB Control Console that no additional record was added to the Database due to the filter expression.
**Figure 3–1  ESB Control Console**
This chapter describes the installation of Oracle JDeveloper. It contains the following topics:

- "Installing Oracle JDeveloper" on page 4-2
- "Opening Oracle JDeveloper" on page 4-2
- "Configuring AS Connection for SOA Suite: OC4J Middle Tier" on page 4-3
- "Configuring Integration Server Connection" on page 4-6

Installing Oracle JDeveloper

Follow these steps to install Oracle JDeveloper:

1. Download jdevstudio1013.zip.
2. Extract the contents of jdevstudio1013.zip file to your local machine such as C:\jdevstudio1013.
3. Navigate to the C:\jdevstudio1013 folder and double-click jdeveloper.exe. The Oracle JDeveloper 10g Start Page is displayed along with the Migrate User Settings message box that asks if you want to migrate from a previous version.
4. Click No. The Oracle JDeveloper 10g Start Page is displayed along with the Tip of the Day dialog box.
5. Click Close. The Oracle JDeveloper 10g Start Page is displayed.
6. Click Help, Check for Updates. The Check for Updates Welcome Page is displayed, as shown in Figure 4–1.
Opening Oracle JDeveloper

To open Oracle JDeveloper, navigate to the C:\jdevstudio1013 folder and double-click jdeveloper.exe. The Oracle JDeveloper Start Page is displayed.

**Note:** Certain features that are not fully tested in Oracle JDeveloper have been marked as "Preview" features, but will be supported in a later release.

You can start the Oracle JDeveloper in the preview mode using the following command:

```
<JDEV_HOME>/jdev/bin/jdev.exe -Dpreview_mode=true
```
To close the Oracle JDeveloper, click Exit on the File menu.

**Configuring AS Connection for SOA Suite: OC4J Middle Tier**

You must configure Application Server connection for SOA Suite. Perform the following steps to configure Application Server connections and to test it:

1. Identify the OPMN port.

   **Note:** To determine the OPMN port, check the `opmn.xml` file in the `Oracle_Home\opmn\conf\` directory, where `Oracle_Home` is the name of the Oracle home where you installed Oracle Enterprise Service Bus SOA Suite.

2. Navigate to the `C:\jdevstudio1013` folder and double-click `jdeveloper.exe`. The Oracle JDeveloper 10g Start Page is displayed.
3. Click the **Connections Navigator** tab. The Connections pane is displayed.

4. Right-click **Application Server**, and select **New Application Server Connection**. The Create Application Server Connection Welcome wizard is displayed.

5. Click **Next**. The Create Application Server Connection Type page is displayed.

6. Enter **LocalApplicationServer** in the Connection Name field and select **Oracle Application Server 10g 10.1.3** from the Connection Type list, as shown in Figure 4–3.

**Figure 4–3  The Create Application Server Connection Type Page**

7. Click **Next**. The Create Application Server Connection Authentication page is displayed.

8. Enter the OC4J username and password, and select the Deploy Password checkbox.

9. Click **Next**. The Create Application Server Connection page is displayed.

10. Enter the local host name in the Host Name field, and the port number in the OPMN Port field, as shown in Figure 4–4.
11. Click Finish. The Application Server connection is displayed in the Connections Navigator page.

12. Right-click LocalApplicationServer and click Properties. The Edit Application Server Connection dialog box is displayed, as shown in Figure 4–5.

13. Click the Test tab. The Test page is displayed, as shown in Figure 4–6.
14. Click **Test Connection**. Success is displayed in the status page, as shown in Figure 4–7.

15. Click **OK**. You have successfully configured the application server connection and also tested it.

**Configuring Integration Server Connection**

Perform the following steps to configure Integration Server connections and to test it.

1. Navigate to the C:\jdevstudio1013 folder and double-click jdeveloper.exe. The Oracle JDeveloper Start Page is displayed.
2. Click the Connections Navigator tab. The Connections pane is displayed.

3. Right-click Integration Server, and select New Integration Server Connection. The Create Application Server Connection Welcome page is displayed.

4. Click Next. The Create Integration Server Connection Name page is displayed.

5. Enter LocalIntegrationServer in the Connection Name field, and click Next. The Create Application Server Connection page is displayed.

6. Select LocalApplicationServer from the Application Server list, enter the host name in the Host Name field, and 8888 in the Port Number field, as shown in Figure 4–8.

Figure 4–8  The Create Integration Server Connection Page

7. Click Finish. The Integration Server connection is displayed in the Connections Navigator page.

8. Right-click LocalIntegrationServer and click Properties. The Edit Integration Server Connection dialog box is displayed, as shown in Figure 4–9.
9. Click the **Test Connection** tab. The Test page is displayed, as shown in Figure 4–10.

**Figure 4–10  The Edit Integration Server Connection Test Page**

10. Click **Test Connection**. The Edit Integration Server Connection Success page is displayed, as shown in Figure 4–11.

**Note:** Ensure that the ESB Server is started before you do this.
11. **OK.** You have successfully configured the integration server connections and also tested it.
This chapter provides step-by-step instructions on creating and running the CustomerData tutorial.

This chapter includes the following topics:

- "Introduction to the CustomerData Tutorial" on page 5-1
- "Step-By-Step Instructions for Setting Up the Tutorial End-to-End" on page 5-2

Introduction to the CustomerData Tutorial

In most business environments, customer data resides in disparate sources, including business partners, legacy applications, enterprise applications, databases, and custom applications. The challenge of integrating this data can be met using Oracle Enterprise Service Bus to deliver appropriate real-time data access to all applications that update or have a common interest in the same data.

For example, Oracle Enterprise Service Bus might accept data contained in a text file, transform it to a format appropriate for updating a database that serves as a customer repository, and route and deliver the data to that database.

To accomplish all the required tasks, Oracle Enterprise Service Bus follows the following basic steps, which are shown in Figure 5–1. These steps are simplified for the purposes of the introductory example. Additional information is provided in the step-by-step portions of this guide.

Figure 5–1 illustrates a scenario in which Oracle Enterprise Service Bus:

1. Receives the customer data from a file system as a text file, through an inbound file adapter service named CustIn. The CustIn adapter service sends the message to a routing service named CustIn_RS.

2. The CustIn_RS routing service transforms the data format from the file adapter’s schema into the canonical XML schema, and sends the message to the routing service named CustOut_RS.

3. The CustOut_RS routing service:

   - Routes the message in the canonical format to the CRMOut file adapter service.
   - Applies a filter to the XML message payload to determine whether the message should be routed to the outbound adapter service for the Customer Information Database, CustDBOut.
   - Invokes the appropriate adapter services (as determined by the filter expression). Routing rules specify that messages bound for the CustDBOut
service be sent synchronously, while those bound for the CRMOut service be sent asynchronously.

– If the receiving adapter service is CustDBOut, then the CustDBOut service is invoked immediately and control is not returned to the CustOut_RS service until the message has been received by CustDBOut.

– If the receiving adapter service is CRMOut, then the message is sent to JMS and control is immediately returned to the CustOut_RS service.

4. The outbound adapter service delivers the message to its associated external application.

*Figure 5–1 Illustration of Scenario*

**Step-By-Step Instructions for Setting Up the Tutorial End-to-End**

This section provides the steps for loading, building, and registering components required for the tutorial scenario, as described in the following topics. These topics should be read and followed in the order in which they are presented.

- "Creating the Directory Structure"
- "Creating an Oracle JDeveloper Application and Project"
- "Importing the Schema Definition (.XSD) Files"
- "Creating an Oracle Enterprise Service Bus System"
- "Creating an Inbound File Adapter Service – CustIn"
- "Creating an Outbound Database Adapter Service – CustDBOut"
- "Creating an Outbound JMS Adapter Service – CRMOut"
- "Creating the Outbound Routing Service – CustOut_RS"
- "Specifying Routing Rules from CustIn_RS to CustOut_RS"
- "Specifying Routing Rules from CustOut_RS to CustDBOut"
- "Specifying Routing Rules from CustOut_RS to CRMOut"
- "Registering Services with Oracle Enterprise Service Bus and Viewing in the ESB Control Console"
- "Adding an Expression Filter to the CustOut_RS Routing Service"
Creating the Directory Structure

Download the CustomerSample.zip file and unzip to the folder C:\Customer. Figure 5–2 illustrates the directory structure used by the CustomerData tutorial. The Customer folder contains following folders and files:

- In folder
- Schema folder: The Schema folder consists of following three XSD files:
  - CommonCustomer.xsd
  - CustomerDB.xsd
  - LegacyCustomer.xsd
- create_customer.sql file
- LegacyCustomer.xml file
- LegacyCustomerCanada.xml file
- query_customer.sql file

![CustomerData Tutorial Directory Structure](image)

Creating an Oracle JDeveloper Application and Project

You create adapter services using Oracle JDeveloper. To begin work in Oracle JDeveloper, you set up the folders that will hold the files related to your application. From the Applications Navigator, you create a folder for your application and a project within that application folder to hold the ESB tutorial files.

To create an application and a project for the tutorial, follow these steps:

1. Open Oracle JDeveloper as described in "Opening Oracle JDeveloper" on page 4-2.
2. In the upper left panel, click the Applications Navigator tab.
3. Right-click Applications, then select New Application. The Create Application dialog box is displayed, as shown in Figure 5–3.
4. In the **Application Name** field, enter *ESBSamples*, and then click **OK**. The Create Project dialog box is displayed.

5. Click **Cancel**.

6. In the Applications Navigator pane, right-click **ESBSamples**, then select **New Project**. The New Gallery dialog box is displayed.

7. From the **Categories** navigator, select **General** and then **Projects**.

8. From the **Items** list, select **ESB Project** as shown in **Figure 5–4**.

**Figure 5–4 The New Gallery Dialog Box**

9. Click **OK**. The Create ESB Project dialog box is displayed, as shown in **Figure 5–5**.
Figure 5–5  The Create ESB Project Dialog Box

10. In the Project Name field, enter CustomerData, and then click OK.

Oracle JDeveloper is displayed, as shown in Figure 5–6. The Applications Navigator is updated with the new application and project and the Design Tab contains, a blank palette.

Figure 5–6  Oracle JDeveloper – Application and ESB Project Added

Importing the Schema Definition (.XSD) Files

The .xsd files that define the structure of the various message formats that will be integrated using Oracle Enterprise Service Bus in this tutorial are included when you install Oracle Enterprise Service Bus. To use them with the ESBSamples application, you must import them, as follows:

1. In the Applications Navigator pane, select CustomerData.
2. From the File menu, click Import. The Import dialog box is displayed, as shown in Figure 5–7.
3. From the **Select What You Want to Import** list, select **Web Source**, and then click **OK**. The Web Source dialog box is displayed, as shown in **Figure 5–8**.

4. To the right of the **Copy From** field, click **Browse**. The Choose Directory dialog box is displayed.

5. Navigate to the following directory, and then click **Select**.

   \C:\Customer\Schemas

   The Web Source dialog box with the directory selected is displayed, as shown in **Figure 5–9**.
6. Click OK.

7. In the Applications Navigator pane, expand CustomerData and then WebContent. The Applications Navigator should appear as shown in Figure 5–10.

![Figure 5–9 The Web Source Dialog Box](image)

![Figure 5–10 Applications Navigator – EBSSamples/CustomerData/Web Content](image)
Creating an Oracle Enterprise Service Bus System

To create adapter services, you must first create the Oracle Enterprise Service Bus system that will contain them, as described in the following list:

**Note:** Before you create the Oracle Enterprise Service Bus system, you need to delete the existing CustomerData system.

To do that, you need to open the ESB Control Console, click the CustomerData system, and click the Delete button. A Delete System dialog box is displayed, click Yes.

1. In Oracle JDeveloper, click Create System/Group icon shown in Figure 5–11.

   **Figure 5–11  The Create System/Group Icon**

   The Create ESB System or Service Group dialog box is displayed, as shown in Figure 5–12.

   **Figure 5–12  The Create ESB System Or Service Group Dialog Box**

2. Select System.

3. In the Name field, enter CustomerData.

4. Click OK.

Creating an Inbound File Adapter Service – CustIn

Using Oracle JDeveloper, create an inbound file adapter service, named CustIn to read in text files. Follow these steps:

1. From the Components Palette, select Adapter Services.

2. Select File Adapter and drag it to the design area.

   The Create File Adapter Service dialog box is displayed.
3. In the Name box, enter CustIn.

4. If CustomerData is not appearing in the System/Group box, then perform the following:
   a. Click Browse.
   b. Select ESB, Systems/Groups in project, CustomerData.
   c. Click OK.

5. In the Adapter Service WSDL section, click the Configure Adapter Service Wsdl icon, shown in Figure 5–13.

Figure 5–13 Adapter Configuration Wizard Icon

The Adapter Configuration Wizard Welcome page is displayed.

6. In the Welcome page, click Next.
   The Service Name page is displayed.

7. Click Next.
   The Operation page is displayed.

8. In the Operation Type field, select Read File.

9. In the Operation Name field, replace Read with ReadCustomerData, as shown in Figure 5–14.
10. Click **Next**. The File Directories page is displayed.

11. In the **Directory for Incoming Files (physical path)** field, enter `C:\Customer\In`, and then click **Next**.

   The File Filtering page is displayed.

12. In the **Include Files with Name Pattern** field, enter `* .xml`, and then click **Next**.

   The File Polling page is displayed.

13. Change the **Polling Frequency** field value to 1 **seconds**, and then click **Next**.

   The Messages page is displayed.

14. Click **Browse**.

   The Type Chooser dialog box is displayed.

15. Expand the navigation tree to **Type Explorer\Project Schema Files\LegacyCustomer.xsd** and then select **CustomerData**, as shown in **Figure 5–15**, and then click **OK**.
Figure 5–15 Type Chooser - CustomerData

The Adapter Configuration wizard appears as shown in Figure 5–16.

Figure 5–16 Adapter Configuration Wizard – Messages page

16. Click Next.

The Finish page is displayed.

17. Click Finish. The Create File Adapter Service dialog box is displayed with CustIn.wsdl appearing in the WSDL File field.

18. Click OK.

The CustIn_RS routing service is created along with the CustIn adapter service.
19. From the **File** menu, click **Save**.

### Creating an Outbound Database Adapter Service – CustDBOut

Create an outbound database adapter service, named **CustDBOut**, to write messages to the Oracle Database Lite database, as follows:

#### Step 1 Begin the Adapter Configuration Wizard

Follow these steps to create an outbound database adapter service:

1. From the Components Palette, select **Adapter Services**.
2. Select Database Adapter and drag it to the design area. The Create Database Adapter Service dialog box is displayed.
3. In the Name field, enter **CustDBOut**.
4. If CustomerData is not appearing in the System/Group box, then perform the following:
   a. Click **Browse**.
   b. Select **ESB, Systems/Groups** in project, **CustomerData**.
   c. Click **OK**.
5. In the Adapter Service WSDL section, click the **Configure adapter service wsdl** icon shown in **Figure 5–13**. The Adapter Configuration Wizard Welcome page is displayed.
6. Click **Next**. The Service Name page is displayed.
7. Click **Next**. The Service Connection page is displayed.
8. Click **New**. The Create Database Connection Welcome page is displayed.

#### Step 2 Begin the Create Database Connection Wizard

Follow these steps to create a database connection:

1. In the Create Database Connection Welcome page, click **Next**. The Create Database Connection Type page is displayed.
2. Enter **Olite** in the Connection Name field and select **Oracle Lite** from the Connection Type list, as shown in **Figure 5–17**.
3. Click **Next**. The Create Database Connection Authentication page is displayed.

4. Specify field values as described in the following list, and click **Next**.
   - Username: System
   - Password: any

   The Create Database Connection page is displayed, as shown in Figure 5–18.

5. Click **Next**. The Create Database Connection page is displayed, as shown in Figure 5–19.
6. Select **Type 4 Driver** from the Driver list, and click the **Browse** button next to the Library field. A Select Library dialog box is displayed, as shown in Figure 5–20.

7. Click **New**. The Create Library dialog box is displayed, as shown in Figure 5–21.
Click the **Add Entry** button. The Select Path Entry dialog box is displayed, as shown in **Figure 5–22**.

Navigate to the **Oracle_Home/integration/ESB/lib/olite40.jar** directory, as shown in **Figure 5–22**, where **Oracle_Home** is the directory specification for the Oracle home where you installed Oracle Enterprise Service Bus.

Click **Select**. The Select Path Entry dialog box closes and the **Library Name** field contains the value **0lite40.jar** in the Create Library dialog box, as shown in **Figure 5–23**.
11. Click **OK**. The Select Library dialog box is displayed with `Olite40.jar` in the **Library Name** field, as shown in Figure 5–24.

12. Click **OK**. The Create Database Connection page is displayed with the **Library** field populated with `Olite40.jar`, as shown in Figure 5–25.
13. Enter the hostname, port, and SID details, as mentioned in the following list:
   - Host Name: localhost
   - JDBC Port: 1531
   - SID: OraESB

   The Create Database Connection page is displayed, as shown in Figure 5–26.

14. Click Next. The Create Database Connection Test page is displayed.

15. Click Test Connection. The Status field contains the string: Success!, as shown in Figure 5–27.
16. Click **Finish**. The Service Connection page is displayed, as shown in Figure 5–28, where the **Connection** field contains **Olite** and **JNDI Name** contains **eis/DB/Olite**.

![The Service Connection Page](image)

You have successfully created a new database connection called **Olite**, which is required to configure the database adapter.

**Step 3 Complete the Adapter Configuration Wizard**

Follow these steps to complete creating the outbound database adapter service:

**Note:** Once you have created a database connection, the Adapter Configuration wizard continues, which enables you to create the outbound database adapter service.
1. In the Service Connection page, as shown in Figure 5–28, click Next.
   The Operation Type page is displayed.

2. In the Operation Type page, follow these steps:
   a. Select Perform an Operation on a Table.
   b. Deselect Insert Only, Update Only, Delete, and Select as shown in Figure 5–29.

   ![Figure 5–29 Adapter Configuration Wizard – Operation Type](image)

   c. Click Next.
   The Select Table page is displayed.

3. In the Select Table page, follow these steps:
   a. Click Import Tables.
   The Import Tables dialog box is displayed.
   b. Select Auto-Query.
   The Import Tables dialog box refreshes and appears as shown in Figure 5–30.
Step-By-Step Instructions for Setting Up the Tutorial End-to-End

5-20 Oracle Enterprise Service Bus Quick Start Guide

Figure 5–30  Import Tables Dialog Box

- In the Available box, select CUSTOMER_DATA and then click the right arrow button.
  The CUSTOMER_DATA is added to the Selected box.

- Click OK. The Select Table page is displayed, as shown in Figure 5–31.

Figure 5–31  Select Table – SYSTEM.CUSTOMER_DATA

- Click Next.
  The Define Primary Keys page is displayed.

4. In the Define Primary Keys page, select CUSTOMERID, and then click Next.
The Relationships page is displayed.

5. Click Finish. The Create Database Adapter Service dialog box is displayed with CustDBOut.wsdl appearing in the WSDL File field.

6. Click OK. You have successfully created the outbound adapter service named CustDBOut.

7. From the File menu, click Save.

Creating an Outbound JMS Adapter Service – CRMOOut

Create an outbound JMS adapter service, named CRMOOut, to write messages to the Customer Relationship Management application, as follows:

1. From the Components Palette, select Adapter Services.

2. Select JMS Adapter and drag it to the design area.

   The Create JMS Adapter Service dialog box is displayed.

3. In the Name box, enter CRMOOut.

4. If CustomerData is not appearing in the System/Group box, then perform the following:
   a. Click Browse.
   b. Select ESB, Systems/Groups in project, CustomerData.
   c. Click OK.

5. In the Adapter Service WSDL section, click the Configure Adapter Service Wsdl icon.

   The Adapter Configuration Wizard Welcome page is displayed.

6. Click Next. The Adapter Configuration Wizard Service Name page is displayed.

7. Click Next. The JMS Provider page is displayed.

8. Select Oracle Enterprise Messaging Service (OEMS) and then select Memory/File as shown in Figure 5–32.
9. Click **Next** in the JMS Provider page.
   The Service Connection page is displayed.

10. Select **LocalApplicationServer** from the Connections list, and click **Next**.
    The Operation page is displayed.

11. In the Operation Type field, select **Produce Message**, and then click **Next**.
    The Produce Operation Parameters page is displayed.

12. Click the **Browse** button next to the **Destination Name** field.
    The Select Destination dialog box is displayed.

13. Select **All Types**, **jms**, **demoTopic(topic)**, as shown in **Figure 5–33**, and click **OK**.
The Produce Operation Parameters page is displayed with all the fields populated, as shown in Figure 5–34.

14. Click Next.

The Messages page is displayed.
15. In the Messages page, follow these steps:

a. Click Browse.

The Type Chooser dialog box is displayed.

b. In the Type Chooser dialog box, expand the navigation tree to Type Explorer/Project Schema Files/CommonCustomer.xsd, and click Customer, as shown in Figure 5–35.

Figure 5–35  Type Chooser – CommonCustomer.xsd

```
Type Chooser
```

![Type Chooser - CommonCustomer.xsd](image)

c. Click OK.

The Messages page appears with the Schema Location field populated with the location of the schema file, as shown in Figure 5–36.
d. Click Next.

The Finish page is displayed.

16. Click Finish. The Create JMS Adapter Service dialog box is displayed with CRMOut.wsdl file appearing in the WSDL File field.

17. Click OK. You have successfully created the outbound service named CRMOut.

18. From the File menu, click Save.

Creating the Outbound Routing Service – CustOut_RS

The outbound routing service, CustOut_RS specifies the route messages will take to arrive at their target destinations.

To create the CustOut_RS routing service, follow these steps using the Oracle JDeveloper:

1. From the Component Palette in the upper right section of Oracle JDeveloper, select ESB Services.

2. Drag the Routing Service from the Components Palette to the design view.

   The Create Routing Service dialog box is displayed.

3. In the Name field, enter CustOut_RS.

4. If CustomerData is not appearing in the System/Group box, then perform the following:
   a. Click Browse.
   b. Select ESB, Systems/Groups in project, CustomerData.
   c. Click OK.

5. Select Generate WSDL From Schemas.

6. Click Browse.

   The Type Chooser dialog box is displayed.
7. In the Type Chooser navigator, expand **Type Explorer, Project Schema Files, CommonCustomer.xsd**, and then select **Customer**.

8. Click **OK**. The Create Routing Service dialog box is displayed with the Schema Location field populated with the URL for the schema file.

9. In the **Operation Name** box, enter **MapCustomerData**. The Create Routing Service dialog box is displayed, as shown in Figure 5–37.

**Figure 5–37 Create Routing Service Dialog Box**

10. Click **OK**. The **CustOut_RS** routing service is created, as shown in Figure 5–38.
Specifying Routing Rules from CustIn_RS to CustOut_RS

Follow these steps to specify the path that messages take from the CustIn_RS routing service to the CustOut_RS routing service:

1. Double-click CustIn_RS.
2. Click the plus (+) button to the left of Routing Rules. The Routing Rules panel is displayed.
3. Click the plus (+) button at the extreme right-hand side of ReadCustomerData. The Browse Target Service Operation dialog box is displayed.
4. Select ESB, Services in project, CustomerData, CustOut_RS, MapCustomerData.
5. Click OK.

The Routing Rules panel is displayed, as shown in Figure 5–39.
6. Click the icon next to the <<Transformation Map>> box. The Request Transformation Map dialog box is displayed, as shown in Figure 5–40.

7. Select Create New Mapper File and click OK.

   A CustomerData_To_Customer.xsl tab is added to the Oracle JDeveloper console, as shown in Figure 5–41. This tab enables you to graphically create a document transformation file to convert the structure of the file data to a canonical data structure.
8. Drag and drop the imp1:CustomerData source element to inp1:Customer target element.

The Auto Map Preferences dialog box is displayed.

9. From the During Auto Map options, deselect Match Elements Considering their Ancestor Names.

The Auto Map Preferences dialog box is shown in Figure 5–42.

10. Click OK.
The CustomerData_To_Customer.xsl tab appears as shown in Figure 5–43.

As you can see, multiple links are created automatically. If you had not deselected the Match Elements Considering their Ancestor Names option, you would have to drag and drop each of the source elements to the target elements, one-by-one.

**Figure 5–43 CustomerData_To_Customer.xsl Tab – Auto Mapped Connections**

![Diagram of CustomerData_To_Customer.xsl connections](image)

11. Expand the inp1:Customer/Profile target element.

12. Drag and drop the imp1:CustomerData/CampaignRating source element to the inp1:Customer/Profile/ActivityRating target element.

The CustomerData_To_Customer.xsl tab appears as shown in Figure 5–44.
13. From the File menu, click Save.

Specifying Routing Rules from CustOut_RS to CustDBOut

Follow these steps to specify the path that messages take from the CustOut_RS routing service to the CustDBOut adapter service:

1. Click the CustomerData.esb tab on the Oracle JDeveloper window.
2. Double-click CustOut_RS. The Routing Service panel is displayed.
3. Click the Plus (+) button to the left of Routing Rules. The Routing Rules panel is displayed.
4. Click the Plus(+) button at the extreme right-hand side of MapCustomerData. The Browse Target Service Operation dialog box is displayed.
5. In the ESB Services navigator, expand ESB/Services in project/CustomerData/CustDBOut/write.
6. Click OK. The Routing Rules panel appears as shown in Figure 5–45.
7. Click the icon next to the <<Transformation Map>> box. The Request Transformation Map dialog box is displayed as shown in Figure 5–40.

8. Select Create New Mapper File, and click OK.
   A Customer_To_CustomerDataCollection.xsl tab is added to Oracle JDeveloper, as shown in Figure 5–46.
9. Drag and drop the `inp1:Customer` source element to the `CustomerData` target element.

   The Auto Map Preferences dialog box is displayed.

10. From the During Auto Map options, ensure the Match Elements Considering their Ancestor Names is deselected.

    The Auto Map Preferences dialog box should appear as shown in Figure 5–42.

11. Click OK. The Customer_To_CustomerDataCollection.xsl tab appears as shown in Figure 5–47.
12. You can expand the CustomerData target element to view the auto mappings.

13. From the File menu, click Save.

**Specifying Routing Rules from CustOut_RS to CRMOut**

Follow these steps to specify the path that messages take from the CustOut_RS routing service to the CRMOut adapter service:

1. Click the CustomerData.esb in the Oracle JDeveloper window.
2. Double-click CustOut_RS routing service.
3. Click the Plus (+) button to the left of Routing Rules. The Routing Rules panel is displayed.
4. Click the Plus (+) button at the extreme right-hand side in the Rules region. The Browse Target Service Operation dialog box is displayed.
5. Expand ESB/Services in Project/CustomerData/CRMOut, select Produce_Message, as shown in Figure 5–48.
6. Click OK. The Routing Rules panel is displayed.

7. In the Applications Navigator, select Applications/ESBSamples/CustomerData/Resources and then double-click CustomerData.esb.

The CustomerData.esb Design tab now appears as shown in Figure 5-49.
8. From the File menu, click Save.

Registering Services with Oracle Enterprise Service Bus and Viewing in the ESB Control Console

Before you can view the services you have created with Oracle JDeveloper ESB Designer in the Oracle Enterprise Service Bus Control Console, you must register them with Oracle Enterprise Service Bus Server.

1. In the Applications navigator, right-click CustomerData, choose Register with ESB, and then click LocalIntegrationServer.

A message displays to indicate that the following services were successfully registered as shown in Figure 5-50:

- CustomerData created
- CustomerData.CRMOut created
- CustomerData.CustDBOut created
- CustomerData.CustOut_RS created
- CustomerData.CustIn_RS created
- CustomerData.CustIn created
2. Click OK.

3. View the Oracle Enterprise Service Bus configuration in the Oracle Enterprise Service Bus Control Console, as follows:
   - If the Oracle Enterprise Service Bus Control Console is currently open:
     Click the refresh button and then click **CustOut_RS**.
   - If the Oracle Enterprise Service Bus Control Console is not open:
     Select **Start, All Programs, Oracle - Oracle_Home, Oracle ESB, ESB Control**, to open the Oracle Enterprise Service Bus Control Console.

The Diagram tab is displayed, as shown in Figure 5–51.
Adding an Expression Filter to the CustOut_RS Routing Service

The following steps describe how to add a filter to the CustOut_RS routing service so that only messages for customers with an address in the United States are sent to the CustDBOut adapter service for updating the customer database. First you need to determine the namespace for the service, then you use that namespace when specifying the filter expression, as follows:

Using the Oracle JDeveloper, follow these steps:

1. Click the CustomerData.esb tab in the Oracle JDeveloper window.
2. Double-click CustOut_RS.
3. Click the filter icon.
   The Expression Builder is displayed.
4. In the WSDL Message box, expand Customer_request, Customer, inp1:Customer, Address and then select Country.
5. Click Insert Into Expression.
6. Specify the country as "US" as follows:
   `/inp1:Customer/Address/Country='US'`
7. Click OK.
8. From the File menu, click Save.
9. Register the CustomerData service as shown in section "Registering Services with Oracle Enterprise Service Bus and Viewing in the ESB Control Console".
   A message is displayed to indicate that the following services were successfully registered:
   CustomerData.CustOut_RS updated
10. Refresh the view in the Oracle Enterprise Service Bus Control Console.

11. Select the CustOut_RS service.

12. Click the Diagram tab.

   A filter icon appears next to the line representing the link between the CustOut_RS routing service and the CustDBOut adapter service, as shown in Figure 5–52.

![Oracle Enterprise Service Bus Control Console – CustOut_RS Filter](image)

**Figure 5–52  Oracle Enterprise Service Bus Control Console – CustOut_RS Filter**

---

**Note:** For instruction on running the tutorial, refer to "Step-By-Step Instructions for Running the Tutorial" on page 3-3.

---

## Demonstrations and Tutorials

A series of demonstrations, activity and conceptual reference materials, and tutorials are also provided to increase conceptual knowledge and hands-on experience with Oracle Enterprise Service Bus. These materials are installed with Oracle Enterprise Service Bus in the Oracle_Home\integration\esb\samples directory.

In addition, you can find updated information about Oracle Enterprise Service Bus at following location:

http://www.oracle.com/appserver/esb.html
hardware requirements for installation, 2-1

icons
  used in Oracle Enterprise Service Bus Console, 1-9
images
  used in Oracle Enterprise Service Bus Console, 1-9
inbound adapter services
  defined, 1-4
installation
  hardware requirements for, 2-1
  software requirements for, 2-1
installation types, 2-3
interservice communication symbol
  used in Oracle Enterprise Service Bus Console, 1-9

JMS
  asynchronous execution type and, 1-6
JMS adapter services
  defined, 1-4

metrics
  displaying in Diagram panel, 1-11
Microsoft .NET
  SOAP invocation services and, 1-3
Microsoft .Net
  connectivity with, 1-3

Native MQSeries adapter services
  defined, 1-4
Navigator panel
  on Diagram tab, 1-11

Oracle BPEL Process Manager
  connectivity with, 1-3
  SOAP invocation services and, 1-3
Oracle Database Lite
  starting, 2-6
Oracle Enterprise Service Bus
  defined, 1-1
  features, 1-3
  installation types described, 2-3
Oracle Enterprise Service Bus Console
  configuration panel and, 1-10
  description of, 1-8
  icons and images used in, 1-9
  introduction to, 1-8
  opening, 2-6
Oracle Enterprise Service Bus Server
  starting, 2-6
Oracle Enterprise Service Bus services and, 1-5
Oracle Enterprise Service Bus system
  creating, 5-8
Oracle JDeveloper
  adapters supported by, 1-7
  Applications Navigator, 1-8
  creating application in, 5-3
  creating project in, 5-3
  introduction to, 1-7
  routing services and, 1-7
  starting, 4-2
  transformations and, 1-7
outbound adapter services
  defined, 1-4
outbound database adapter service
  creating CustDBOut, 5-12
outbound JMS adapter service CRMOut
  creating, 5-21
Overlay Metrics panel
  on Diagram tab, 1-11

project
  creating in Oracle JDeveloper, 5-3

relationship among services
  displaying in Oracle Enterprise Service Bus Console, 1-10
routing
  XML messages, 1-5
routing rules
  configuring, 1-5
  defined, 1-5
  document transformations and, 1-5
  execution type and, 1-5
  filter expressions and, 1-5
Routing Rules tab
  described, 1-11
routing service
  creating CustOut RS, 5-25
  defined, 1-5
routing service image
  used in Oracle Enterprise Service Bus Console, 1-9
routing services
  Oracle JDeveloper and, 1-7

scenario
  used for tutorial, 5-1
schema files
  importing into Oracle JDeveloper, 5-5
service group
  defined, 1-10
service groups
restrictions on, 1-10

service icon
used in Oracle Enterprise Service Bus Console, 1-9

services
creation as SOAP services, 1-5
Definition tab and, 1-11
described, 1-9
gear icon and, 1-9
registering with Oracle Enterprise Service Bus, 5-36
routing rules of, 1-12

services group icon
used in Oracle Enterprise Service Bus Console, 1-9

services navigation tree
described, 1-9
system folder and, 1-9

SOAP invocation services, 1-3
Apache Axis and, 1-3
Microsoft .NET and, 1-3
Oracle BPEL Process Manager and, 1-3
SOAP services, 1-5
software requirements for installation, 2-1
stacked disks icon
systems and, 1-10

system
defined, 1-9

system folder
in services navigation tree, 1-9

system icon
used in Oracle Enterprise Service Bus Console, 1-9

systems
defined, 1-9
stacked disks icon and, 1-10

T

target services
defined, 1-5
transformation icon
used in Oracle Enterprise Service Bus Console, 1-9

transformations
Oracle JDeveloper and, 1-7
tutorial
scenario description, 5-1

W

WSDL URL
using to invoke a service, 1-5

X

XML messages
routing, 1-5
.xsd files
importing into Oracle JDeveloper, 5-5